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1 Tixi Message Modems im Uberblick

1.1 Was ist das Besondere ?

Die Tixi Message Modem AT Produktfamilie umfasst neuartige, intelligente Kommunikationsgerate,
die — ohne PC - mit einem einfachen Kommando Nachrichten versenden und empfangen kdénnen,
je nach Tixi-Modem z.B.

SMS im Festnetz und in das Mobilnetz
Fax Senden von Texten und Daten als Fax
E-Mail per Internet

Express E-Mail' E-Mail ohne Internet, d.h.
E-Mail direkt per Telefonleitung

EINE Nachricht mit EINEM Befehl an EIN Ziel senden

Mit dem Tixi AT Modem brauchen Sie zum Versenden und Empfangen von Nachrichten und Daten keinen
Kommunikationsspezialisten. Kenntnisse Uber irgendwelche ,Protokolle” braucht man auch nicht - denn Tixi-
Modems haben die géngigen Nachrichtenprotokolle bereits eingebaut und erledigen den Kommunikations-
prozess vollautomatisch.

Wie bei einem Faxgerat geben Sie nur die Zieladresse und den Text (oder die Daten) ein,
- den Rest fuhrt das Tixi AT Modem selbst aus. Z.B. mit diesen einfachen Befehlen:

Kommando Parameter Text oder Daten

AT+T Send="EMail; To:Taskforce@Firm.com" Tank 17, Haus 5, ist leer!
AT+T Send="Express; To:Service+49-30-12345678" Brenner im Haus 6 ausgefallen!
AT+T Send="'SMS; To:0177-3456678" Temperatur Kuehlraum zu hoch!
AT+T Send="'Fax; To:0891-98745561" Luefter 17 defekt!

Nach dem Ende der Ubertragung gibt Tixi eine Quittung liber die Zustellung der Nachrichten oder Daten aus.
Haben Sie vergessen, wie ein Befehl aussieht, verwenden Sie den HELP-Befehl:

AT+T HELP

Tixi AT Modems sind kleine Kommunikationscomputer mit Speicher und eingebautem Modem, die 24 Stunden
am Tag bereit sind, Daten und E-Mails zu senden und zu empfangen.

Tixi AT Modems erdffnen véllig neue Mdglichkeiten fiir die Industriekommunikation. So kénnen Sie lhre
Steuerung (SPS) mit Tixi AT Modems leicht um Fernmeldefunktionen erweitern. Die Steuerung sendet bei
Ereignissen (Stérungen, Zustande) die entsprechenden Kommandos an das Tixi AT Modem, das daraufhin die
E-Mails, Faxe, SMS oder Express E-Mails automatisch verschickt.

Tixi Super Modem AT und Tixi Message Modem AT
Das Tixi Super Modem AT ist ein preisgunstiges Einstiegsmodem mit weniger Datenspeicher und mit weniger
Funktionen als das Tixi Message Modem AT. Es kann durch den nachtraglichen Einbau eines Speichermoduls
(2 MB: SX02) jederzeit erweitert werden. Weiteres siehe 1.2.1

Alle Geréate der Tixi Message Modem AT Produktfamilie werden im Folgenden als Tixi AT Modems oder Tixi
Message Modems bezeichnet.

Analoge und ISDN-Modems
Tixi Modems sind als analoge und ISDN-Modelle erhéltlich. Die Bedienung bzw. die Befehle unterscheiden sich
jedoch nicht.

! Mit dem Express-E-Mail Verfahren kénnen E-Mails ohne Internet direkt per Telefonleitung an den Empfanger gesendet
werden, siehe Bild , Tixi Communication Ways" im Anhang E. Ein Internet-Provider ist fiir Express E-Mail nicht nétig.
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1.2 Kurzubersicht Uber die Tixi Automatik-Modems

1.2.1 Tixi Super Modem AT

Den Einstieg bildet das Tixi Super Modem AT: Ein Tixi-Modem mit 50...100 kB RAM-Speicher (je nach Funktion)
zum automatischen Versenden und Empfang von SMS-Nachrichten und Express-E-Mails. Dieses Tixi-Modem
kann mit 2 MB stromausfallsicherem Flash-Speicher aufgeriistet werden und unterstiitzt dann auch Internet E-
Mail und - in der Variante SM03 (mit analogem Modem) - auch den Faxversand.

1.2.2 Tixi Message Modem AT

Die nachste Stufe ist das Tixi Message Modem AT. Es ist bereits von Hause aus mit 2 MB stromausfallsicherem
Flash-Speicher ausgestattet und beherrscht den Versand und Empfang von SMS, Express-E-Mail und Internet
E-Mail. AuBerdem konnen mit den Varianten EM20 und EF20 Fax-Nachrichten versandt werden.
Alle Modelle dieser Reihe lassen sich mit bis zu 8 MB Flash-Speicher aufristen.

Conrad C-Control I+l
Fur die Steuerungen C-Control | + Il werden kostenlose Programmmodule TxMessage angeboten.

1.2.3 Tixi Alarm Modem

Die Tixi Alarm Modems haben 2 MB Flash-Speicher und kénnen bis auf 66 MB erweitert werden. Sie werden in
diesem Handbuch zwar nicht beschrieben, es soll jedoch ein kurzer Uberblick gegeben werden.

Alarm- oder Stérungsmelder

Im Gegensatz zu den Tixi Message Modems arbeiten Tixi Alarm Modems vollkommen automatisch. Der
Versand von Nachrichten (Fax, SMS, Pager, E-Mail, Express-E-Mail) kann Uber optionale 1/0-Ports oder ber
direkt angeschlossene Steuerungen gestartet werden. Dabei kénnen nicht nur beliebige Texte als Vorlagen fir
Nachrichten (Templates) verwendet werden, sondern diese Texte kénnen auch Werte von I/O-Ports oder Werte
z.B. aus der angeschlossenen Steuerung enthalten. Zum Zeitpunkt des Alarmes werden vom Tixi Alarm Modem
die aktuellen Werte gelesen, in den Text eingebaut und die Nachricht dann versandt.

Tixi.Com bietet analoge und ISDN-Modelle sowie Modelle mit internem GSM-Modem an.

Fernwirken

Eingehende Nachrichten kénnen Schaltbefehle an Output-Ports oder in der SPS ausldsen und den Zustand des
Tixi-Modems und der angeschlossenen Gerate wahlweise melden oder protokollieren. Die Schaltbefehle, z.B.
per SMS, kdnnen ein Passwort enthalten. Es kann automatisch eine Nachricht Uber die erfolgreiche oder
fehlerhafte Ausfiihrung der Befehle generiert und versandt werden.

Ferneinwahl (TransMode)
Tixi Alarm Modems kdnnen per Ferneinwahl mit Passwort konfiguriert werden. Ebenso ist die Einwahl durch ein
Tixi Alarm Modem hindurch in eine Steuerung mdglich, ohne dass die Steuerung dafiir programmiert sein muss.

Datenlogger
Alle Ereignisse (Events) und Variablen kénnen mit Zeit- und Datumsstempel gespeichert und zu bestimmten
Zeiten per E-Mail verschickt werden. Fernauslesen der geloggten Daten per Modem ist mdglich.

I/O-Karten mit 8 — 24 1/0O-Ports, RS 232, RS 422/485

Es werden verschiedene |/O-Karten angeboten a) mit einer zweiten RS 232 (St.) oder b) mit RS 232 (St.) und
RS 422/485. Eine Karten hat 8 Ports: 5 Input und 3 Output, eine andere 24 Ports: 16 Input und 8 Output.
Sondermodelle mit 24 Input- oder 24 Outputports sind ebenfalls erhaltlich.

Tixi Alarm Modems und SPS-Systeme
Es gibt Modelle der Tixi Alarm Modems, die bekannte SPS/Systeme direkt unterstitzen, z.B.

Tixi EZ Alarm Modem fiir Moeller EASY 400/600/800
Tixi SB Alarm Modem fir Saia Burgess PCD und PCS
Tixi S72 Alarm Modem fiir Siemens Simatic S7-200 / 300 Modelle.

Tixi Alarm Modems kommunizieren mit diesen SPSen in deren jeweiligem Protokoll, so dass keine Programme,
Treiber oder Funktionsblécke in die SPSen geladen werden missen. Tixi kann alle wichtigen Variablen oder
Ports der SPS lesen und schreiben.

Fir die Steuerungen Conrad C-Control | + 1l werden die kostenlosen Programmmaodule TxAlarm angeboten.
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1.3 Varianten:

Gehé&use und Stromversorgung

L
| I.i.::-r""": LA
! \\ :' oy u-) T S
~{d
Office Line (Typ: CTS) Office Line (Typ: BB) Industry Line (Typ: KA5)
9V AC mit 230 V Netztell 12 V AC mit 230 V Netzteil Schraubklemme: 12 — 24 vV DC
(landerabhéangig) (landerabhangig)
1.4 Tixi Message Modem Features
Typ SMS Fax E-Mail |Express| Datenspeicher
mobil | Festnetz E-Mail Grund- | erweiter-
speicher | bar um
Tixi Super Modems
SMO03 50...100
Tixi Super Modem AT V.90 ° ® | ®v | @& ° kg | 2MB
SD03 50...100
Tixi Super Modem AT ISDN ° ® ° kg | 2MB
Tixi Message Modems
EM20
Tixi Message Modem AT V.90 ¢ ¢ ¢ ¢ ¢ 2MB | 8MB
ED20
Tixi Message Modem AT ISDN ¢ ¢ ¢ 2MB | 8MB
EF20 ?
Tixi Message Modem AT ISDN & Fax | ® ¢ ¢ ¢ ¢ 2MB | 8MB

1
2)

Express E-Mail:

SMS mobil

Diese Funktion ist nur mit 2 MB Speichererweiterung (SX02) nutzbar.
mit Echtzeituhr (RTC) und Lithiumbatterie zur Sicherung der Uhrzeit bei Stromausfall.

Mit dem Express-E-Mail Verfahren kdnnen E-Mails ohne Internet direkt per Telefonleitung an
den Empfanger gesendet werden, siehe auch das Bild , Tixi Communication Ways" im Anhang.
Ein Internet-Provider ist fiir Express E-Mail nicht nétig.

Einzige Voraussetzung: der Empfénger hat ein Tixi-kompatibles Modem.

Alle Tixi AT Modems kénnen SMS ins Mobilfunknetz senden.
Ein Empfang von SMS im Festnetz ist bei diesem Verfahren von den Mobilfunknetzbetreibern
nicht vorgesehen.

SMS im Festnetz ist ein spezieller Dienst der Deutschen Telekom, der es ermdglicht,

Datenspeicher:

im Festnetz SMS zu empfangen und zu senden. Alle analogen Tixi-Modems (SM, EM, JM)
und alle Tixi-ISDN-Modems mit Faxfunktion (EF, JF) unterstiitzen dieses Feature.

Der Grundspeicher (50 — 100kB) der Tixi Super Modems AT ist nicht stromausfallsicher
(SRAM).

Der Grundspeicher (2 MB) der Tixi Message Modems und Tixi Alarm Modems ist
Flash-Memory und deshalb stromausfallsicher.

Alle Speichererweiterungen sind Flash-Memory und halten die Daten auch bei Stromausfall.
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2 Schnelleinstieg

2.1 Konfiguration am PC

Im Allgemeinen wird ein Tixi-Modem zunachst an einem PC getestet und konfiguriert.

Schliessen Sie das Tixi-Modem mit dem mitgelieferten Kabel an eine serielle Schnittstelle Ihres PC an.
Verwenden Sie das beiliegende Telefon- oder ISDN-Kabel, um das Tixi-Modem mit dem Telefonnetz zu
verbinden. SchlieRen Sie es dann an die Stromversorgung an. Falls Sie ein SM03-CTS benutzen, betétigen Sie
den Netzschalter an der rechten Seite.

Zum Testen des Tixi-Modems kann jedes Terminalprogramm (115200 Bd, 8N1) oder TACO, die Tixi AT-
Console (s.u.), verwendet werden.

2.2 Zuerst den Message Mode aktivieren

Das Tixi-Modem befindet sich nach dem ersten Einschalten im Modem Mode.
Dies ist an der rot leuchtenden Modem Mode LED erkennbar; in diesem Modus kann das Tixi-Modem als
normales AT-Modem z.B. zum Internet-Surfen oder Faxen vom PC verwendet werden.

Damit das Tixi-Modem die Tixi Message-Kommandos erkennt,
muss es in den Message Mode geschaltet werden:

1. AT+T Mode="MessageMode" Dieses Kommando aktiviert den Message Mode.
Die Modem Mode LED verlischt.

AT+T Mode="ModemMode"* Der Message Mode bleibt solange aktiv, bis mit diesem Befehl
wieder der Modem Mode aktiviert wird.

Zum Testen werden die folgenden Kommandos empfohlen:
2. AT+T Echo="on" - Aktiviert die Anzeige der eingegebenen Kommandos am Bildschirm.

3. AT+T Verbose="on" - Schaltet ausfuhrliche Ruckantworten ein,
die mehr Aufschluf? Gber die Aktionen des Modems geben als nur "OK" oder "Error".

4, AT+T Time="J3JJII/MM/TT,hh:mm:ss,+0100" — Setzt die Uhrzeit im Tixi-Modem,
die z.B. fur die Zeit und das Datum in der Faxkopfzeile verwendet wird.

Nun kdnnen die Message Modem-Befehle ,per Hand“ mit dem Terminalprogramm oder mit TACO ausprobiert
werden. Dann kann das Tixi-Modem an die Steuerung angeschlossen werden.

2.3 Tixi-Modem an einer Steuerung

Tixi-Modem — Null-Modem-Kabel — Steuerung

Achtung! Das mitgelieferte RS232-Modemkabel (1:1-Kabel) ist nur fir die Verbindung
zwischen dem Tixi-Modem und einem PC geeignet.

Blue Adapter

Null-Modem-Kabel
Um das Tixi Super Modem AT oder das Tixi Message Modem AT mit

RS 232-Buchse an eine Steuerung mit RS 232 Buchse 9pol Stecker 9pol Stecker
anzuschlieBen, muss ein Nullmodem-Kabel (Stecker-Stecker) 2 2
verwendet werden. Verwenden Sie einen "Blue Adapter" (erhaltlich ><

bei lhrem Handler) zusammen mit dem RS232-Modemkabel, um ein 3 3
solches Nullmodem-Kabel zu erhalten. Der blaue Adapter ist wie folgt 5 5
geschaltet: 4
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2.4 Super Modems und Message Modems mit Conrad C-Control | + 11

Fur diese beiden Steuerungen bietet Tixi.Com kostenlose Beispielprogramme (Funktion TxMessage) und ein
Handbuch an. (Siehe beiliegende CD.) Mit den Programmen laR3t sich ein Tixi-Modem konfigurieren und steuern.

2.5 Test 1: Ein Fax versenden
Der Faxversand ist méglich mit dem EM20, EF20 und SM03 mit 2 MB Speicherkarte (SX02).)
1. Setzen Sie zuerst die allgemeinen Parameter fiir alle Nachrichtentypen:

AT+T Send="ALL ;DialPrefix:nnn;ModemName :Name ;ModemNumber :Number"

Ersetzen Sie dabei die kursiv gedruckten Angaben durch die fur Ihren Anschluss zutreffenden Werte:

nnn Amtvorwahl des Anschlusses (optional)
Name Geben Sie hier einen Namen fiir lhr Tixi-Modem an.
Number Nummer des Telefonanschlusses, an dem das Tixi-Modem arbeitet.

2. Senden Sie die erste Nachricht mit dem Befehl:
AT+T Send=""Fax;Dial :Rufnummer"

Rufnummer Nummer des Empfangers, inklusive Ortskennzahl (falls erforderlich).

3. Eingabe des Textes der Nachricht.
Nachdem Sie den AT+T Send. . . Befehl an das Tixi-Modem gesendet haben, erscheint ein Prompt-
Zeichen (>), hinter dem Sie die Nachricht eingeben kénnen. Umlaute sind nicht erlaubt.
Die erste Zeile ist der Betreff, d.h. die Uberschrift, die folgenden Zeilen sind der Text der Nachricht.
Schliessen Sie jede Zeile mit ENTER ab.
Zum Beenden der Eingabe und um den Versand zu starten, driicken Sie auf einer neuen Zeile die Tasten
<STRG>+<Z>.
Auf diese Weise wird der Text fiir alle anderen Nachrichtentypen eingegeben.

Sollte auf die Befehlseingabe statt des Prompt-Zeichens ein "ERROR" folgen, war die Syntax des Befehls
fehlerhaft. Prifen Sie in diesem Fall alle Eingaben ab AT+T und wiederholen Sie diese korrekt.

4. Beobachten Sie das Tixi AT Modem.
Die Mail-Out LED leuchtet, sobald eine ausgehende Nachricht erzeugt wurde.
Die griine Line LED blinkt wahrend des Verbindungsaufbaus und
leuchtet dauerhaft, sobald die Verbindung hergestellt ist. Die Nachricht wird dann versandt.
Diese LED verlischt, wenn die Verbindung getrennt ist (entspricht dem Auflegen des Telefonhorers).

5. Meldung: Nach Abschluss der Ubertragung gibt das Tixi AT Modem
(z.B. im Terminalprogramm) eine Meldung tber den Versand aus.

2.6 Test 2: Eine Express-E-Mail versenden

Um eine Express E-Mail Nachricht versenden und empfangen zu kénnen, bendétigen Sie einen Partner, der ein
Tixi-kompatibles Modem betreibt.

Zum einmaligen Antwort-Test kdnnen Sie folgende Express E-Mail Adresse bei Tixi.Com benutzen:
Tixi-Reply+49-30-40608-555

1. Der Befehl AT+T Send=“ALL...“ (s.0.) muss nur 1x am Anfang gesendet werden.

2. Senden Sie die Express E-Mail-Nachricht mit dem Befehl:
AT+T Send="Express;Dial:Rufnummer;To:Empfanger;From:Absender"

Rufnummer  Nummer des Empfangers, inklusive Ortskennzahl (falls erforderlich).
Empfanger  Express-E-Mail Adresse des Empfangers (z.B. Fritz+49-89-9876543)
Absender Ihre Express-E-Mail Adresse (z.B. Hans+49-30-12345678)

3. Eingabe des Textes und Ablauf wie beim Fax (s.0.)
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2.7 Test 3: Die empfangene Express E-Mail auslesen

Warten Sie einen Moment, bis die Nachricht verschickt wurde. Das Tixi-Mail System im Hause der Firma
Tixi.Com GmbH wird Ihre Nachricht empfangen und automatisch eine Antwort an die Absender-Adresse
zuriicksenden (Das dauert ca. 3-6 Minuten). So kdnnen Sie prifen, ob Ihr Tixi-Modem korrekt angeschlossen
und konfiguriert ist.

Sobald das Tixi-Modem die Antwort empfangen hat - wahrend des Empfangs leuchtet die griine Line-LED -
kénnen Sie an der rot leuchtenden Process LED (oder Mail-in LED) erkennen, dass sich eine Nachricht im
Speicher befindet. Um diese auszulesen, gehen Sie wie folgt vor:

1. Senden Sie den List-Befehl:
AT+T List="ALL" zeigt eine Liste der gespeicherten Nachrichten an.

Die Zeilen dieser Liste beginnen mit +T List= ID-Nummer...
- merken Sie sich die Nummer hinter dem Gleichheitszeichen,
denn diese ist die ID-Nummer der betreffenden Nachricht.

2. Benutzen Sie den Read-Befehl, um diese Nachricht auszulesen:
AT+T Read=I1D

Ersetzen Sie 1D durch die ID-Nummer der gewlnschten Nachricht (Schritt 1).
Die Nachricht wird daraufhin vom Tixi-Modem ausgegeben (z.B. an das Terminalprogramm).

3. Wenn Sie die Nachricht nicht mehr benétigen, 16schen Sie diese mit dem De lete-Befehl:
AT+T Delete=ID

Dass die Nachricht aus dem Speicher des Tixi-Modems geléscht wurde, erkennen Sie daran, dass die rote
Process oder Mail-in LED nicht mehr leuchtet. Wenn sie doch noch leuchten sollte, befinden sich noch
weitere Nachrichten im Speicher, die Sie mit LIST anzeigen lassen kénnen.

2.8 SMS senden

Das Senden einer SMS ist ebenso einfach und wird in Kapitel 5.2.3 beschrieben.
Es wird jedoch dringend empfohlen, zuvor das Kapitel 3 zu lesen, um insbesondere die weniger bekannten
Moglichkeiten des Sendens und Empfangens von SMS im Telefon-Festnetz zu beachten.

2.9 Schneller Einstieg mit TACO, der Tixi AT-Console

Um lhnen die Arbeitsweise der Tixi-Modems zu verdeutlichen, bietet Tixi.Com das Programm TACO, die Tixi
AT-Console, an. Dieses Tool erméglicht einen einfachen Einstieg in die Konfiguration und Bedienung des Tixi
AT Modems, ohne dass Sie das Handbuch studieren missen. Nahere Hinweise zur Installation und Bedienung
von TACO finden Sie im Kapitel 7.

2.10 Tixi-Modems als Modems fiuir den PC

Um das Tixi AT Modem unter Windows auch als "normales” Modem oder ISDN-TA nutzen zu kénnen, missen
die auf der beiliegenden CD-ROM befindlichen Modemtreiber installiert werden. Die ndtigen Schritte sind im Tixi
AT Modem-Handbuch beschrieben, das Sie ebenfalls auf der CD-ROM finden. Dieses enthdlt auch eine
Beschreibung des im Tixi AT Modem implementierten Standard-Hayes-AT-Befehlssatzes. Dieses Handbuch ist
jedoch nur fur Spezialisten interessant und im normalen Betrieb nicht erforderlich.
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3 Senden und Empfangen von SMS

3.1 Mobilfunk-SMS oder Festnetz-SMS ?
Es gibt zwei Arten, SMS vom Festnetz” zu versenden:

e SMS an einen Mobilfunkempfanger (z.B. ein Handy oder GSM-Modem)
e SMS an einen speziellen Empfanger im Telefon-Festnetz

Der Empfang von SMS im Festnetz ist nur unter speziellen Bedingungen méglich (s. Kapitel 3.3.2):

e Empfangsgeréat mit der Funktion SMS-im-Festnetz
z.B. einige DECT-Telefone, einige TK-Anlagen, Tixi-Modems.

e Anmeldung an einem Festnetz-SMS-Service-Center (s.u.)

3.2 SMS in das Mobilfunk-Netz senden

Um eine SMS an einen Mobilfunk-Empfanger (wie Handy SMS iiber Mobilfunk-Gateways
oder GSM-Modem) zu senden, muss das jeweilige SMS-

Gateway angegeben werden: -
Deutschland: ' I

D1 0171-2521002 (analog), 0171-2521001 (ISDN) [_-_-- o

D2 0172-2278025 (analog), 0172-2278010 (ISDN) PC it lﬂd B Hand
Eplus 0177-1167 mit Wodem y
Osterreich: _ _ _

Al  0900-664914 (nur analog) Diese Mobilfunk-SMS-Gateways (SMSC) arbeiten
Schweiz: nur in EINE Richtung: Festnetz - Mobilnetz.
NatelD 079-4998990 (UCP)

Bei diesem Verfahren wird die SMS von einem Absende-Modem oder PC bei dem SMS-Service-Center nur
-abgegeben” und dann die Verbindung beendet.

Eine Antwort, ob und wann die SMS beim Empfanger angekommen ist, gibt es nicht, denn das Service-Center
~weild" nicht, wer die SMS abgegeben hat und kann den Absender nicht benachrichtigen.

Das Senden einer SMS vom Mobilnetz in das Festnetz ist liber diese SMSC nicht méqglich.
(Die SMS wird als Sprachnachricht vorgelesen, nicht als Text tbermittelt.)

3.3 SMS im Festnetz empfangen und senden

SMS im Festnetz wird bisher nur von der Deutschen SMS uber Festnetz-Gateways
Telekom und einem speziellen SMS-Provider, Anny Way,

Uber TK-Leitungen der Deutschen Telekom angeboten. - I

Verwenden Sie die Nummern dieser SMSC, —

um SMS im Festnetz zu senden und zu empfangen: _ ﬂf,';ﬂ%’_
mi tauglich

Deutsche Telekom AG: 0193010 Tixi-Modem Festnetzgerat

AnnyWay: 09003266900

Beachten Sie, dass Sie fiir den Empfanger der Nachricht das richtige Adressformat angeben.
Die Adresse besteht aus der Ortskennzahl, direkt gefolgt von der Telefonnummer.
Beachten Sie, dass die Ortskennzahl mit fiilhrender Null angegeben werden muss.

Damit die SMS als Text-Nachricht ankommt, missen Sender und Empfanger das gleiche SMSC verwenden.
Andernfalls erfolgt eine Wandlung in eine Sprach-Nachricht.

SMS im Festnetz ist ein relativ junges Leistungsmerkmal der Deutschen Telekom. Anderungen und
Erweiterungen sind nicht ausgeschlossen. Aktuellste Informationen zum Thema finden Sie im Internet bei T-
Com oder bei AnnyWay unter http://www.sms-im-festnetz.de.

% Festnetz: Analoges und ISDN-Telefonnetz
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Die volle Nutzung der SMS-Features der Tixi AT Modem Familie ist derzeit bei Anschlissen méglich, die im
Ortsnetz Uber die Deutsche Telekom AG vermittelt werden.

Wenn Sie Ihre Telefonrechnung nicht von der Deutschen Telekom AG erhalten, dann fragen Sie bitte bei lhrer
Telefongesellschaft nach, welche Leistungsmerkmale lhr Anschluss bzgl. SMS im Festnetz unterstitzt.

3.3.1 SMS empfangen im Festnetz

Um SMS uber das Festnetz zu empfangen, muss das Dienstmerkmal CLIP an lhrem Telefonanschluss
freigeschaltet sein und von einer ggf. zwischengeschalteten Telefonanlage bzw. ISDN-ab-Wandler unterstitzt
werden. Erkundigen Sie sich ggf. bei Inrem Telefonanbieter oder TK-Anlagen Hersteller.

Wenn |hr Anschluss oder Endgerat nicht korrekt fiir Festnetz-SMS eingerichtet ist, wird jede eingehende SMS
vorgelesen.

3.3.1.1 SMS lber die Deutsche Telekom empfangen

Damit SMS als Textnachricht Gibertragen und nicht vorgelesen werden, muss der betreffende Anschluss dafur
freigeschaltet sein. Dazu missen Sie lediglich eine SMS mit dem Text ANMELD an die Rufnummer 8888 senden.
Um die Freischaltung zu beenden, reicht eine SMS mit dem Text ABMELD an dieselbe Adresse.

3.3.1.2 SMS uber AnnyWay empfangen

Um SMS uber diesen Anbieter empfangen zu kénnen, miissen Sie zuvor von diesem Anschluss aus eine SMS
versandt haben; dadurch wird der betreffende Anschluss fiir den Empfang von Text-SMS freigeschaltet. Sollte
der Empfang von AnnyWay deaktiviert worden sein, so lasst er sich mit einer SMS an 2547 (Text: "CLIP" ohne
Anfiihrungszeichen) wieder aktivieren.

3.3.2 SMS im Festnetz — im Detail
Um SMS im Festnetz nutzen zu kdnnen, sind diese Voraussetzungen notwendig:

1. Die Ubermittlung der eigenen Rufnummer bei
ausgehenden Rufen muss aktiviert sein. Tixi Message Modem
(Telekom-Dienstmerkmal CLIR aktiviert.) (Telekom-Festnetz)

2. Die Anzeige der Rufnummer eingehender Rufe
muss aktiviert sein.

(Telekom-Dienstmerkmal CLIP aktiviert.) SMSC DT AG SMSC Anny Way
(0193010) (09003266900)

3. Der Festnetz-Anschluss muss am SMSC? als
SMS-tauglich angemeldet sein.

4. Das Endgerat muss SMS-tauglich sein. SMS-Empfanger
(Telekom-Festnetz)

Der Telefonanbieter muss das Feature "SMS
im Festnetz" anbieten.

Nachrichten kénnen tber beide SMSC versandt werden. Damit SMS in Textform in jedem Fall empfangen
werden kdnnen, empfiehlt es sich, im Gerat beide SMSC fur den Empfang zu konfigurieren.

Die Nachrichten werden Uber die SMSC-Gateways der jeweils benutzten Mobilfunkanbieter versandt.

® SMSC: SMS Service Center
10
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Empfang von SMS

T-Mobile Vodafone O,/E-plus
Teilnehmer Teilnehmer Teilnehmer
(0172-XXXXXXX) (0172-XXXXXXX) (0L 7X-XXXXXXX)

y
SMSC D1 SMSC D2 SMSC Oy/E-plus
(Rufnummer It. SIM- (Rufnummer It. SIM- (Rufnummer It. SIM-
Karte) Karte) Karte)
y
SMSC-Festnetz Tixi Message Modem AT SMSC-Festnetz
Deutsche Telekom (Telekom-Festnetz) AnnyWay

SMS aus dem D1-Netz werden im Festnetz Gber das SMSC der Deutschen Telekom AG empfangen, wahrend
Nachrichten aus dem D2- und O2-Netz Uiber das SMSC des Anbieters Anny Way empfangen werden.

11
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4 Tixi Message-Modus

Bevor eine Nachricht mit den Tixi-Message-Befehlen verschickt werden kann,
muss zuerst der Tixi Message Mode aktiviert sein. Siehe dazu Kapitel 2.2 (AT+T Mode=""MessageMode").

4.1 Ablauf beim Senden einer Nachricht

Der grundlegende Aufbau des Sendebefehls ist stets gleich -
unabhangig davon, welchen Nachrichtentyp oder welches Tixi-Modem Sie benutzen:

AT+T Send="Nachrichtentyp; Parameter"

Folgende Nachrichtentypen sind z.Z. méglich:

SMS SMS senden

Fax Text als Fax senden
Express Express E-Mail senden
EMail Internet E-Mail senden
POP3 Internet E-Mail abholen

Die Parameter enthalten die jeweils notwendigen Angaben, wie die Adressen von Absender und ggf.
Empfanger, Internet-Zugangsdaten oder die Rufnummer des SMS-Service-Centers.

Der Befehl zum Versand einer SMS kdnnte etwa so aussehen:
AT+T Send="'SMS;T0:017312345678;ServiceCentreNumber:0193010""

Beachten Sie, dass ein Befehl maximal 200 Zeichen lang sein darf. Teilen Sie ggf. die Parameter auf mehrere
Befehle auf.

Nach der Eingabe des Sendebefehls wird vom Tixi-Modem ein Prompt (>) zurtickgeschickt, hinter dem Sie den
Text der Nachricht eingeben kénnen. Bei einer SMS waren dies 160 Zeichen in einer Zeile fortlaufend.

Zum Absenden beginnen Sie eine neue Zeile (benutzen Sie dazu die ENTER-Taste) und driicken Sie dann die
Tasten <STRG>+<Z> als Kennzeichen fur das Ende der Eingabe des Textes.

Bei Message Modems mit 2MB Grundspeicher stehen maximal 700KB fiir den Nachrichtentext (E-Mail, Fax,
Express-E-Mail) zur Verfiigung.

4.2 Informationen zu Tixi AT Kommandos

Die speziellen AT-Kommandos fiir den Message-Modus kénnen genauso wie die "normalen" AT-Kommandos
des Hayes-Befehlssatzes verwendet werden. Fir jedes dieser Kommandos lassen sich die bereits
konfigurierten Werte sowie eine Liste der mdglichen Parameter anzeigen; die Syntax ist bei jedem Kommando
gleich.

4.2.1 Konfigurierte Werte ausgeben , ?*

Um rasch einen Uberblick zu erhalten, welche der Parameter bereits mit Werten "gefiillt" sind, senden Sie das
Kommando, gefolgt von einem Fragezeichen.
Kommando, um z.B. die bereits konfigurierten Parameter des Send Kommandos auszugeben:

AT+T Send?

4.2.2 Liste der Parameter ausgeben: ,=?*

Wenn Sie sich nicht sicher sind, welche Parameter fiir ein bestimmtes Kommando angegeben werden mussen,
oder wie deren Syntax lautet, hilft Ihnen der Parameter-Abfragebefehl.

Senden Sie das jeweilige Kommando, gefolgt von ,=?".

Kommando, um z.B. die mdglichen Parameter des Send Kommandos auszugeben:

AT+T Send=?

Gibt eine Liste aller Parameter aus, die fur das ,SEND“-Kommando gelten.
So kénnen Sie jederzeit Uberprifen, ob Sie die Werte vollstandig angegeben haben, und welche noch fehlen.

12
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4.3 Ruckmeldungen beim Versand von Nachrichten

4.3.1 Meldung nach jedem Versand einer Nachricht

Nachdem ein Sendebefehl an das Tixi-Modem geschickt wurde, wird - nach Abschlul? des Versandes - eine
Meldung generiert, die die wichtigsten Angaben zum Sendevorgang enthalt.

Falls Sie den Schalter Verbose=""0ff"" gesetzt haben, werden nur Kurzmeldungen ausgegeben
(OK oder Error).
Bei Verbose="0n" enthalten die Rickmeldungen ausfiihrliche Angaben zum Nachrichtenversand.

Diese Meldungen haben grundsétzlich folgendes Format:
+T Send: sending message

* StartTime: Beginn Zeitpunkt des Starts der Ubertragung
* EndTime: Ende Zeitpunkt des Endes der Ubertragung
* Connect: Speed Connect-Meldung des Modems

OK OK-Antwort des Modems

Je nach Nachrichtentyp werden weitere Informationen angegeben.

Die ausfiihrlichen Riickmeldungen sind wichtig, um Verbindungen zu testen und im Fehlerfall die Ursache
schnell finden zu kénnten.

4.3.2 Express-E-Mail

Zusatzinformation nach dem Versand einer Express E-Mail:

* RemoteBoxName: BoxName Name der Tixi-Mail Box* beim Empfanger
* RemoteBoxNumber: Nummer Rufnummer der Tixi-Mail Box beim Empféanger
* RemoteBoxSerial: Serien# Seriennummer der Tixi-Mail Box beim Empfanger
4.3.3 Fax
Zusatzinformation nach dem Versand einer Faxnachricht:
* Faxldentify: ID Stations-ID des empfangenden Faxgerates
* Pages: Seiten Zahl der Ubertragenen Seiten
* Baudrate: Speed Geschwindigkeit der Ubertragung
4.3.4 SMS

Zusatzinformation nach dem Versand einer SMS:
* SMSC-Time: Zeit Der Zeitstempel des Service-Centers
Uber das die SMS versandt wurde.
4.3.5 Versand von Internet E-Mail

Nach dem Versand einer Internet E-Mail erhalten Sie keine zuséatzlichen Informationen.

4.3.6 Abholung von Internet E-Mail

Zusatzinformation nach der Abholung von Internet E-Mail (POP3):

* DetectedMails: Zahl1l Anzahl der in der Mailbox erkannten Nachrichten
* DetectedSize: Grossel GroRRe der erkannten Nachrichten

* ReceivedMails: Zahl2 Anzahl der abgeholten Nachrichten

* ReceivedSize: Grosse2 GrolRe der abgeholten Nachrichten

* Tixi-Mail Box: Ein Tixi-kompatibles Modem mit Speicher (2 MB — 36 MB), das an einem PC betrieben wird und E-Mails
und Express E-Mails senden und empfangen kann, ohne dass ein PC eingeschaltet sein muss. (S.a. Graphik , Tixi
Communication Ways" auf der letzten Seite (Anhang E)). Tixi-Mail Boxen kommunizieren mit allen gangigen E-Mail-
Programmen (wie Outlook, Outlook Express u.a. SMTP/POP3-Programmen), nicht jedoch mit AOL.

13
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5 Tixi Message Befehle

Diese erweiterten Befehle kénnen Sie im Message Mode an das Tixi AT Modem senden.
(Im Modem Mode fiihren diese Befehle zu einem Error.)

5.1 Ubersicht der Befehle

Senden von Nachrichten

AT+T Send="All;__." setzt allgemeine Sendeparameter
AT+T Send="SMS;..." sendet eine SMS (je nach Gerat)
AT+T Send="Fax;..." sendet ein Fax (je nach Gerat)
AT+T Send="EMail;..." sendet eine Internet E-Mall

AT+T Send="POP3;..." holt Internet E-Mail vom Provider ab
AT+T Send="Express;..." sendet eine Express E-Malil

Steuerung und Konfiguration

AT+T Send? gibt die aktuelle Konfiguration aus

AT+T List gibt eine Liste der empfangenen Nachrichten aus

AT+T Read gibt empfangene Nachrichten aus

AT+T Delete I6scht empfangene Nachrichten

AT+T Time setzt die Systemzeit

Time? gibt die Systemzeit aus

AT+T Echo schaltet das lokale Echo ein oder aus

AT+T Verbose schaltet ausfuhrliche Rickmeldungen ein oder aus

AT+T MSN setzt die MSN von ISDN-Geraten

AT+T Speaker setzt die Lautstarke des Modemlautsprechers

AT+T Answer schaltet die Anrufannahme ein oder aus

AT+T Erase setzt das Tixi AT Modem zurlick (Factory defaults)

AT+T Redial setzt die Anzahl der Wahlwiederholungen (default=0)

AT+T RedialDelay legt die Pause zwischen zwei Wahlversuchen fest (default=90)

AT+T DialRules legt das Wahlverfahren und Wéahltonverhalten fest

AT+T Mode schaltet zwischen Modem Mode und Message Mode um

AT+T Help gibt eine Ubersicht der erweiterten Befehle aus

AT+T Format wahlt das Datenformat auf der seriellen Schnittstelle
Ferneinwahl

AT+T Send="TransMode;..." Ferneinwahl in Tixi-Modem und Transparent Mode durch die RS 232

auf die angeschlossene Steuerung s. Kapitel 6

Erlauterung der AT+T-Befehle auf den folgenden Seiten:

AT+T Send ="All;..." Befehl in Kurzform
AT+T Send = "ALL; ....“ Syntax des Befehles mit allen Parametern
Text Beschreibung des Befehls

Parameter mit Erlauterung

Beispiel

14
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5.2 AT+T Send — SMS, E-Mail, Fax, Express E-Mail senden

5.2.1 Allgemeine Tixi-Modem-Parameter setzen

AT+T Send="All;..."

AT+T Send="ALL ;DialPrefix:nnn;ModemName :Name ;ModemNumber :Nummer ;End:char"

Dieser Befehl setzt die Parameter, die allen Nachrichtentypen gemeinsam sind;
eine Nachricht wird dabei nicht versandt.
Nach diesem Kommando kann kein Nachrichtentext eingegeben werden!

nnn: Amtsholung

Falls das Tixi AT Modem an eine Telefonanlage angeschlossen ist und diese eine Vorwahl
fur die Amtsleitung erfordert, so soll diese hier angegeben werden.
Es dirfen nur "wahlbare" Zeichen (0-9, *, #, Komma) benutzt werden.
Wenn keine Amtsholung benétigt wird, kann dieser Parameter entfallen.

Name: Beim Senden von Faxnachrichten wird dieser Name in der Kopfzeile des versandten
Faxes und als Tixi-Box-Name fur den Versand von Express E-Mail verwendet.
Es sind maximal 16 alphanumerische Zeichen erlaubt.

Nummer: Nummer des Telefonanschlusses, mit dem das Tixi-Modem verbunden ist.
Sie muss im internationalen Format angegeben werden, also z.B.. +49-30-1234567.
Diese Nummer wird in Kopfzeilen von Faxnachrichten und als Absender fir Express E-Mail
verwendet.

Char: Definiert das Zeichen, welches die Nachrichteneingabe abschlief3t. Standard:
<STRG>+<Z>

Beispiel:
Setzt die Amtsvorwahl "0", den Tixi-Modem-Namen "Tixi.Com GmbH" und
die Telefonnummer "+49-30-1234567":

AT+T Send="All;DialPrefix:0;ModemName:Tixi.Com GmbH;
ModemNumber :+49-30-1234567""

5.2.2 Ein Fax senden

AT+T Send="Fax;..."

AT+T Send="Fax;Dial :Nummer"
>SubjectText

>MessageText Zeile#l
>MessageText Zeile#n
><STRG>+<Z>

Dieser Befehl sendet eine Textnachricht als Fax oder speichert diese Parameter.

Nach dem Abschluss der Kommandozeile durch <CR/LF> sendet das Tixi AT Modem ein Prompt-Zeichen (>),
hinter dem die Betreff-Zeile angegeben werden kann. In den darauf folgenden Zeilen wird der Nachrichtentext
eingegeben. Um diesen abzuschliel3en, driicken Sie die Tasten <STRG>+<Z>.

Ohne Eingabe der Nachricht werden lediglich die Einstellungen gespeichert.

Nummer : Rufnummer des Empfanger-Faxgerates.
Es durfen nur "wéhlbare" Zeichen (0-9,* #,Komma) benutzt werden.

SubjectText: Erste Zeile des Nachrichtentextes. Sie bildet die Betreffzeile der Faxnachricht.

MessageText Zeile#l...n: Weitere Zeilen des Nachrichtentextes.
Jede Zeile wird nach dem durch das Modem gesendeten Prompt-Zeichen eingegeben und
durch <CR/LF> abgeschlossen.

Beim Versenden werden Zeilen tber 75 Zeichen automatisch umgebrochen. Umlaute sind
nicht erlaubt.
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Beispiel:

AT+T Send="'Fax;Dial :40578747"
>Hallo Paul

>Das ist die wichtige Nachricht als Fax.
>

>Bis bald.
><STRG>+<Z>

Kurze Modemantwort: OK

5.2.3 SMS senden

AT+T Send="SMS;..."

AT+T Send=""SMS;To:Empfanger;ServiceCentreNumber:SCNummer;Type:Protokoll"
>MessageText
><STRG>+<Z>

Dieser Befehl sendet eine SMS.

Nach dem Abschluss der Kommandozeile durch <ENTER> (<CR/LF>) sendet das Tixi-Modem ein Prompt-
Zeichen (>), hinter dem der Nachrichtentext einzeilig, fortlaufend angegeben wird.
Zum Beenden und Senden driicken Sie <ENTER> und dann die Tasten <STRG>+<Z>.

Ohne Eingabe der Nachricht werden lediglich die Einstellungen gespeichert.

SCNummer : Nummer des jeweiligen SMS Service Centers.
Dieser Parameter muss auch zum Empfang von SMS gesetzt sein, da tber diese Nummer
die Erkennung eingehender SMS-Anrufe erfolgt.
Es dirfen nur "wahlbare" Zeichen (0-9, Komma) benutzt werden.

Empfanger: Nummer des Empfangers der SMS — zumeist eine Handynummer.

Protokoll: Protokoll des jeweiligen SMS-Service Centers. Giltige Werte sind:
D1 TAP SMS lber D1-SMSC senden (an D1-Handy)
Mobilkom_A_TAP SMS lber Mobilkom-Austria-SMSC senden
D2_UCP SMS lUber D2-SMSC senden (an D2-Handy)
PSTN SMS Uber Festnetz-SMSC senden
(z.B: an Festnetz-Gerate oder Handies)

Wenn nichts angegeben ist, wird automatisch dasjenige Protokoll verwendet,
das vom Host der Empfanger-Rufnummer unterstiitzt wird (nur in Deutschland).

MessageText: Nach dem Prompt wird der SMS-Text eingegeben und durch <CR/LF> abgeschlossen.
Fir den Text einer SMS dirfen — einschliesslich des <CR/LF> - maximal 160 Zeichen
verwendet werden. Umlaute sind nicht erlaubt. Der SMS-Text ist als fortlaufender,
einzeiliger Text einzugeben.

(Das <CR/LF> Zeichen wird durch das Driicken der ENTER Taste erzeugt.)

Beispiel:
a) Eine SMS wird gesendet, wobei der Sende-Befehl alle notwendigen Parameter konfiguriert:

AT+T Send="'SMS;T0:071365776;ServiceCentreNumber:0193010"
>Hier folgt der Text der Nachricht.
><STRG>+<Z7>

Ausfihrliche Modemantwort:

+T Send: sending message

* StartTime: 2001/10/30,09:42:13
* EndTime: 2001/10/30,09:42:26

* SMSC Time: 2001/10/30,09:42:48
oK
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b) Eine SMS wird gesendet, wobei der Sende-Befehl die bereits konfigurierten Parameter (u.a.
Empfangernummer) verwendet:

AT+T Send="'SMS;"
> Hier folgt der Text der Nachricht.
><STRG>+<Z>

Kurze Modemantwort:
OK

Hinweis: Die Rufnummern der SMS-Service-Center finden Sie im Kapitel 3 dieses Handbuches.

5.2.4 Express E-Mail versenden

AT+T Send="Express;..."

AT+T Send="Express;To:Empfanger;Dial :Nummer;From:Sender"
>Subject

>MessageText Zeile#l

>MessageText Zeile#n

><STRG>+<Z>

Dieser Befehl sendet eine Express E-Mail.

Nach dem Abschluss der Kommandozeile durch <CR/LF> sendet das Tixi AT Modem ein Prompt-Zeichen (>),
hinter dem die Betreff-Zeile angegeben werden kann. In den darauf folgenden Zeilen wird der eigentliche
Nachrichtentext eingegeben. Um diesen abzuschliessen, driicken Sie die Tasten <STRG>+<Z>.

Ohne Eingabe der Nachricht werden lediglich die Einstellungen gespeichert.

Nummer : Dies ist die Nummer, die zum Anwahlen des Empféangers (z.B. einer Tixi-Mail Box® oder
eines Tixi Super Modems gewahlt werden muss.
Geben Sie die Nummer exakt so an, wie sie gewahlt werden muss - inklusive aller Landes-
oder Ortsvorwahlen.
Lassen Sie die Amtsvorwahl weg, die bei den allgemeinen Parametern angegeben wurde.

Empfanger: Express E-Mail Adresse des Empfangers, z.B. PAUL+49-30-1234567.
Diese wird in das To: Feld im Kopf der versandten Express E-Mail eingefiigt.
Sender: Express E-Mail Adresse des Absenders, z.B. 0TTO+49-30-7654321.

Diese wird in das From: Feld im Header der versandten Express E-Mail eingefiigt.

Subject: Betreffzeile der Nachricht.
Diese wird immer aus der ersten Zeile generiert, die nach dem Prompt eingegeben wird.

MessageText Zeile#n: Weitere Zeilen des Nachrichtentextes.

Jede Zeile wird nach dem vom Tixi-Modem gesendeten Prompt-Zeichen eingegeben und
durch <CR/LF> abgeschlossen.

Beim Versenden werden Zeilen tiber 75 Zeichen automatisch umgebrochen. Umlaute sind
nicht erlaubt.

Beispiel:
Eine Express-E-Mail wird gesendet, wobei der Sende-Befehl alle notwendigen Parameter konfiguriert:

AT+T Send="Express;Dial:1234567;From:0TT0+49-30-7654321;
To:PAUL+49-30-1234567"

>Hallo Paul,

>Der Lufter in Raum 123 in Haus 12 ist ausgefallen.

>
>Gruss Hans.
><STRG>+<7>

Kurze Modemantwort: OK

5 Tixi-Mai Box: Ein Tixi-Modem mit 2 MB — 66 MB Speicher, das fir einen PC als ,E-Mail-Anrufbeantworter” fungiert.
Eine Tixi-Mail Box kann E-Mails empfangen und senden, auch wenn der PC ausgeschaltet ist. E-Mails
werden in den Ublichen E-Mail-Programmen, z.B. Outlook, bearbeitet (POP3 und SMTP).
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5.2.5 Internet E-Mail senden (SMTP)

AT+T Send="Email;..."

AT+T Send="Email;To:Empfanger;Dial :Nummer ;From:Sender;Flags:flag;
Username:SMTP-User ;Password:SMTP-Password;
PPPUser :User ; PPPPassword:Password;SMTPMai IServer : SMTPServer"
>Subject
>MessageText Zeile#l
>MessageText Zeile#n
><STRG>+<Z>

Dieser Befehl sendet eine Internet E-Mail.

Nach dem Abschluss der Kommandozeile durch <CR/LF> sendet das Tixi-Modem ein Prompt-Zeichen (>),
hinter dem die Betreff-Zeile angegeben wird.

In den folgenden Zeilen wird der eigentliche Nachrichtentext eingegeben.

Um diesen abzuschliessen, driicken Sie die Tasten <STRG>+<Z>.

Ohne Eingabe der Nachricht werden lediglich die Einstellungen gespeichert.

Nummer : Rufnummer des Internet-Providers.
Es dirfen nur "wahlbare" Zeichen (0-9,* #,Komma) benutzt werden.

Sender: Internet-E-Mail Adresse des Absenders der Nachricht, z.B.. paul@company . com.
Diese Adresse wird fuir das From: Feld der ausgehenden Nachricht verwendet.
Empfanger: Internet-E-Mail Adresse des Empfangers der Nachricht, z.B.. otto@provider .net. Diese
Adresse wird fur das To: Feld der ausgehenden Nachricht verwendet.
flag Geben Sie hier ,PbS* an, wenn POP-before-SMTP verwendet werden soll, oder ESMTP,

wenn eine SMTP-Authentifizierung nétig ist. Diese erfordert die Angabe von SMTP-
Benutzer mit Passwort.
Ist keine Authententifizierung nétig, kann der Parameter weggelassen werden.

SMTP-User: SMTP-Benutzername fiir ESMTP.
SMTP-Password: SMTP-Passwort fir ESMTP.

User: PPP-Benutzername zur Einwahl in den Internet-Provider.
Password: PPP-Passwort.
SMTPServer: Name oder |IP-Adresse des SMTP-Servers, der die Nachricht versenden soll, z.B.

mail .provider.com.

Subject: Betreffzeile der E-Mail.
Diese wird immer aus der ersten Zeile generiert, die nach dem Prompt eingegeben wird.

MessageText Zeile#l...n: Weitere Zeilen des E-Mail-Textes.
Jede Zeile wird nach dem vom Modem gesendeten Prompt-Zeichen eingegeben und durch
<ENTER> abgeschlossen.

Beim Versenden werden Zeilen tber 75 Zeichen automatisch umgebrochen. Umlaute sind
nicht erlaubt.

Beispiel:
Eine Internet E-Mail wird gesendet:

AT+T Send="EMail;Dial:0191011;From:RT343@T-Online.de;
To:TaskForce@Tixi .Com;
PPPUser:00001234567844556677#0001 ; PPPPassword:Rose;
SMTPMai IServer:mailto.t-online.de"

>Hallo Paul,
>Das ist die wichtige Nachricht per E-Mail.
><STRG>+<Z>

Kurze Modemantwort:
OK
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5.2.6 Internet E-Mail abholen (POP3)

AT+T Send="POP3;..."

AT+T Send="POP3;Dial:Nummer;PPPUser: ISP-User ;PPPPassword: ISP-PW;Flags:Flag;
Username:Mai Ibox;Password:Mai IPW; POP3Mai IServer:POP3Server"

>START

><STRG>+<Z>

Dieser Befehl prift die angegebene E-Mailbox (POP3) und startet ggf. die Abholung von Internet E-Mail.
Jede vollstandig heruntergeladene Nachricht wird auf dem POP3 Server geldscht.

Wenn E-Mails in den Tixi-Speicher abgeholt wurden, leuchtet die rote Process/Mail-in LED am Tixi-Modem.

Achtung! Da es sich um ein Send-Kommando handelt, erscheint auch hier ein Prompt,
nachdem Sie den Befehl eingegeben haben.
Dricken Sie ENTER und STRG+Z, dann wird die Mailabholung gestartet. Wenn Sie ESC
driicken, werden die Einstellungen fir spatere Mailabholungen gespeichert.

Nummer : Rufnummer des Internet-Providers.
Es durfen nur "wahlbare" Zeichen benutzt werden (0-9, *, #, Komma).
I1SP-User: PPP-Benutzername zur Einwahl beim Internet-Provider.
I1SP-PW: PPP-Passwort.
Flag: DontDelete Mails werden nicht vom Server geldscht
Delete Mails werden vom Server geldscht
Mai lbox: Benutzername der Mailbox (POP3) zur Anmeldung am Mail-Server.
Mai I1PW: Passwort der Mailbox.
POP3Server: Hostname oder IP-Adresse des POP3-Mail-Servers, der die Nachricht vorhalt, z.B.

mail .provider.com.

Beispiel:  Die Mailbox Meyer (Passwort: Else) auf dem Mail-Server mail .provider .com wird abgefragt.

Zum PPP-Login wird der Benutzername Richard und das Passwort Tina benutzt:

AT+T Send="POP3;Dial:2345678;PPPUser:Richard;PPPPassword:Tina;
Username:Meyer ;Password:Else;
POP3Mai lServer:mail _provider.com"

>START

><STRG>+<Z>

Modemantwort: OK

* DetectedMails: Zahl1 Anzahl der in der Mailbox erkannten Nachrichten
* DetectedSize: Grossel Grol3e der erkannten Nachrichten
* ReceivedMails: Zahl2 Anzahl der abgeholten Nachrichten
* ReceivedSize: Grosse2 Grole der abgeholten Nachrichten

Da die Konfigurationsparameter nur bei der erstmaligen Konfiguration notwendig und dann optional sind, kann
die laufende Mailabholung auch mit dem folgenden Kurzkommando gestartet werden:

AT+T Send=""POP3"

><STRG>+<Z>

5.3 AT+T List - empfangene Nachrichten anzeigen

AT+T List = "Typ"

Gibt eine Liste aller empfangenen Nachrichten des angegebenen Nachrichtentyps zurtck.

Typ: Der Typ der auszulesenden Nachrichten. Folgende Typen werden unterstutzt:
ALL Alle Nachrichten
SMS SMS (mobil und Festnetz).
Express Express E-Mail.
EMail Internet E-Mail.
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Antwort:

+Tlist=EintragNr#l, Typ#l, Zeit#l
+Tlist=EintragNr#2, Typ#2, Zeit#2
+Tlist=EintragNr#n,Typ#n,Zeit#n
oK

EintragNr#n: Nummer des Eintrags.
Mit dieser Nummer kann die betreffende Nachricht referenziert werden,
um sie auszulesen oder zu l6schen.

Typ#n: Nachrichtentyp des n-ten Eintrags in der Liste.
Zeit#n: Zeitstempel der betreffenden Nachricht. Er wird vom Tixi AT Modem generiert, wenn
die Nachricht vollstandig empfangen wurde.
Beispiel:
AT+T List=""ALL" Alle empfangenen Nachrichten anzeigen.
Modemantwort:

+T List=11,SMS,2001/10/7,12:05:55

+T List=12,SMS,2001/10/7,12:10:16

+T List=21,Express,2001/10/7,12:22:27
OK

AT+T List=""SMS" Alle empfangenen SMS werden angezeigt.

Modemantwort:

+T List=11,SMS,2001/10/7,12:05:55
+T List=12,SMS,2001/10/7,12:10:16
OK

5.4 AT+T Delete - eine gespeicherte Nachricht [dschen

AT+T Delete=Nummer..

Ldscht die Nachricht mit der angegebenen Nummer aus dem Speicher des Tixi AT Modem.

Nummer : Nummer der Nachricht, die geléscht werden soll.
Diese Nummer kann durch das List Kommando ermittelt werden. Um die erste

gespeicherte Nachricht (also die alteste) zu l6schen, geben Sie als Nummer eine 0 (Null)

an.

Beispiel: Eine Nachricht mit der Nummer 11 wird gel6scht:
AT+T Delete=11

Modemantwort: OK

5.5 AT+T Read - eine gespeicherte Nachricht auslesen

AT+T Read=Nummer..

Liest die Nachricht mit der angegebenen ID aus dem Speicher des Tixi AT Modem aus.
Die Nachricht wird dabei nicht geléscht und kann beliebig oft ausgelesen werden.

Nummer : Nummer der Nachricht, die ausgelesen werden soll.
Diese Nummer kann durch das List Kommando ermittelt werden.
Um die erste gespeicherte Nachricht (das ist die alteste) auszulesen,
geben Sie eine 0 (Null) an.
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Antwort:
Kurze Antwort (AT+T Verbose="0Fff"):

+T Read= Nummer, Typ, Zeit
*Nachricht
OK

ausfuhrliche Antwort (AT+T Verbose="0n""):

+T Read: Nummer, Typ, Zeit
"ParameterListe"
*Nachricht

OK

Beispiel: Eine SMS mit der Nummer 11 wird ausgelesen:
AT+T Read=11

Modemantwort:

+T Read: 11, SMS, 2001/10/07,12:05:55
“"From:071346768422; TimeStamp:2001/10/07,12:05:37"
*Das ist eine Nachricht von Hans !

oK

5.6 AT+T Answer - das Antwortverhalten festlegen

Schaltet die Anrufannahme des Modems ein oder aus. Diese Einstellung ist flir den Nachrichtenempfang
ausschlaggebend.

Beispiel: Die Anrufannahme ausschalten:
AT+T Answer="0ff"

Modemantwort: OK

Zeigt die aktuelle Einstellung an.

Beispiel:
AT+T Answer?
Modemantwort:
+T Answer: "On"
oK
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5.7 AT+T Time - Systemzeit

AT+T Time="Zeit"

Setzt die Systemzeit des Tixi-Modems,
die fur interne Zeitstempel, Datumsfelder fir SMTP-Nachrichten und Fax-Kopfzeilen genutzt wird.
Die interne Systemzeit muss bei allen Tixi-Modems gesetzt werden:

- nach Erstanschluss

- nach Zeitumstellungen (Normal-/Sommerzeit)

- bei Einsatz in anderen L&ndern/Zeitzonen

- bei Geréaten ohne Batterie-gepufferte RTC (Echtzeituhr)
nach Trennung von der Stromversorgung/Stromausfall.

Die Zeit sollte von der steuernden Anwendung nach Erfordernis tberpriuft und ggf. gesetzt werden.

Zeit: Format der zu setzenden Systemzeit:
JIII/MM/TT, hh:mm:ss, Zeitzone

JJJJ: Jahr (1980....2036)

MM: Monat (01...12)

TT: Tag (01..31)

hh: Stunde (00..23)

mm: Minuten (00...59)

Ss: Sekunden (00...59)

Zeitzone: Zeitzone, in der sich das Tixi-Modem befindet.

Der Wert gibt die Differenz zur GMT an,
mit dieser Syntax: +/-HHMM (z.B. +0100 fir CET / MEZ).

Beispiel: Die Systemzeit des Tixi AT Modem wird auf den 24.1.2003, 12:16:00 CET gesetzt:
AT+T Time="2003/01/24,12:16:00,+0100"

Modemantwort: OK

Die aktuelle Systemzeit auslesen:

AT+T Time?

Liest die Systemzeit des Tixi AT Modem aus.
Beispiel:

AT+T Time?

Modemantwort:

+T Time: 2003/1/24,12:17:00,+0100
OK

5.8 AT+T Echo - das Echo ein- oder ausschalten

AT+T Echo=" OnOff*

Schaltet das Echo fir Tastatureingaben ein oder aus.

OnOff: On Echo eingeschaltet (default)
Off Echo ausgeschaltet
Beispiel: AT+T Echo="0On"

Modemantwort: OK
AT+T Echo?

Zeigt die aktuelle Einstellung an.
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Beispiel:
AT+T Echo?
Modemantwort:
+T Echo: "On"
oK

5.9 AT+T Verbose - ausfuhrliche Antworten ein- oder ausschalten

Schaltet die ausfuhrlichen Antworten des Tixi-Modems ein oder aus.

Beispiel:  AT+T Verbose="0n"
Modemantwort: OK
ATTvebose?
Zeigt die aktuelle Einstellung an.
Beispiel:
AT+T Verbose?
Modemantwort:
+T Verbose: "On"
OK

5.10 AT+T MSN - bei ISDN-Modems die MSN setzen

Setzt die MSN des Tixi AT Modem, sofern es sich um ein ISDN-Gerat handelt.
Fur analoge Geréte hat dieser Befehl keine Bedeutung.

Beispiel: Setzt die MSN auf 12;
AT+T MSN="12"

Modemantwort:  OK
Setzt die Default-MSN:
AT+T MSN=""*"
Modemantwort:  OK
ATTMSN?
Zeigt die aktuelle Einstellung an.
Beispiel:
AT+T MSN?
Modemantwort:
+T MSN:z ™
OK
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5.11 AT+T Mode — ModemMode oder MessageMode einstellen

AT+T Mode="Modus"

Setzt den Betriebsmodus des Tixi-Modems.

ModemMode: Tixi-Modem arbeitet wie ein "normales" Modem bzw. ein ISDN-TA.
Es gelten die Standard Hayes AT-Befehle.
Die Tixi-Message Befehle gelten nicht.
Die rote Modem Mode LED leuchtet.

MessageMode: Die automatischen Funktionen des Tixi AT Modems sind aktiviert und nutzbar.
Dieser Modus muss eingeschaltet sein,
sonst kdnnen die hier beschriebenen Message Kommandos nicht genutzt werden !!
Die Standard Hayes AT-Befehle gelten nicht.
Die Modem Mode LED ist ausgeschaltet.

Weitere Modi fir andere Tixi-Modem-Produkte: TiXMLMode, TixiMode (Modem Mode LED aus.)

Modus: ModemMode (default)
MessageMode
Beispiel: AT+T Mode=""MessageMode"" Schaltet den Mesage Mode ein.

Modemantwort: OK (die Modem Mode LED geht aus)

Nutzen Sie auch: AT+T Mode? zeigt den aktuellen Modus an
und AT+T Mode=? zeigt die moglichen Modi an

5.12 AT+T Help - eine Befehlstubersicht anzeigen

AT+T Help

Gibt eine Ubersicht tiber den liber den erweiterten Befehlssatz des Tixi Message-Modems.
So kénnen Sie bei der Arbeit mit dem Tixi-Modem jederzeit auf die wichtigsten Informationen zugreifen, auch
wenn das Handbuch einmal nicht zur Stelle sein sollte. (Keine Parameter.)

5.13 AT+T Erase - das Tixi AT Modem zuriicksetzen

AT+T Erase

Dieser Befehl setzt das Tixi-Modem zuriick. Dabei wird das Modem neu gestartet, alle benutzerdefinierten
Einstellungen werden geldscht und das Gerat wird in den Auslieferungszustand (Factory defaults) versetzt.

5.14 AT+T Redial — Wahlwiederholung

AT+T Redial="Wiederholungen"

Setzt die Zahl der automatischen Wahlwiederholungen.
Wiederholungen 0...9 (default=0)

Beispiel: AT+T Redial=""3"

Modemantwort: OK

AT+T Redial?

Zeigt die konfigurierte Zahl der automatischen Wahlwiederholungen an. (Keine Parameter)
AT+T Redial?
Modemantwort:

+T Redial:"3"
OK
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5.15 AT+T RedialDelay — Verzogerung Wahlwiederholung

AT+T RedialDelay="Pause"

Legt die Wartezeit in Sekunden zwischen automatischen Wahlwiederholungen fest.
Pause 60...600 (default=90)

Beispiel: AT+T RedialDelay="120"

Modemantwort: OK

AT+T RedialDelay?

Zeigt die Wartezeit zwischen automatischen Wahlwiederholungen an. (Keine Parameter)
AT+T RedialDelay?
Modemantwort:

+T RedialDelay:"90"
OK

5.16 AT+T DialRules —Wahlverfahren, Wahltonverhalten

AT+T DialRules="Wahlverfahren,Wahltonverhalten"

Bestimmt das Wahlverfahren und die Erkennung des Wahltons.
Wahlverfahren :
Tone: Tonwahlverfahren (MFV) (default)
Pulse: Impulswahlverfahren IWV
wahltonverhalten :
NoWaitForDialTone: kein Warten auf den Wahlton (ATX3)
WaitForDialTone : Warten auf den Wahton (ATX4)
Beispiel: AT+T DialRules="Tone,NoWaitForDialTone"
Modemantwort: OK
AT+T DialRules?

Zeigt die Einstellung des Wahlverfahrens und des Wahltonverfahrens an. (Keine Parameter)
AT+T DialRules?

Modemantwort:

+T DialRules: "Tone,NoWaitForDialTone"
oK

Achtung: IWV ist bei Default-Einstellung Europa (CTR21) nicht vorgesehen! Bei Bedarf aktivieren Sie die
zutreffende Landerkennung geméass Modem-Handbuch.
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5.17 AT+ T Speaker - den Lautsprecher einstellen

Stellt die Lautstarke des Modem-Lautsprechers ein.
Dieser Befehl gilt nur fir analoge Tixi-Modems (SM03, EM20) und fir das EF20.

Beispiel: AT+T Speaker="Middle"
Modemantwort: OK
AT+T Speaker?
Zeigt die aktuelle Einstellung an.
Beispiel:
AT+T Speaker?
Modemantwort:
+T Speaker: "OfFf"
OK

5.18 AT+T Format — Datenformat

Schaltet das Datenformat auf der seriellen Schnittstelle um.

Beispiel: AT+T Format="'8E1"
Modemantwort: OK

Zeigt das derzeit aktive Datenformat an
AT+T Format?

Modemantwort:
8E1
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6 RS 232-Transparent-Modus (TransMode)

Der TransMode ermdglicht es, eine Steuerung (SPS) oder ein anderes RS-232-Gerét iber ein Tixi-Modem
fernzusteuern — so als ob man neben den Gerat sitzt und lokal per RS 232 verbunden ware.

Samtliche Befehle, die Sie diesem Geréat Uiber die lokale RS 232-Schnittstelle geben kdnnen, lassen sich ber
den TransMode auch von jedem beliebigen Telefonanschluss oder per GSM-Modem erteilen.

Die Einwahl kann durch ein Passwort geschitzt werden.

Eine Anwendung des TransMode-Befehles wéare zum Beispiel die Steuerung und Konfiguration einer
technischer Anlage, die Uber eine RS 232-Schnittstelle mit dem Tixi Message Modem AT verbunden ist.

Um den TransMode zu nutzen, gehen Sie so vor:

1.
2.

Konfigurieren Sie das Tixi Message Modem AT mit dem TransMode Befehl.

Schliessen Sie das Tixi-Modem an das Gerat an, das Sie fernsteuern mdchten.
Dazu bendétigen Sie ein Null-Modemkabel (meist Stecker-Stecker), z.B. den ,Blue Adapter”.

. Testen Sie die Ferneinwahl mit einem Tixi-Modem oder einem anderen Modem mit Hilfe eines

Terminalprogrammes (Anwahl des Tixi Message Modems).

Innerhalb von 5 Sekunden nach dem CONNECT des Modems
muss das Login-Kommando an das angewahlte Tixi Message Modem gesendet werden. S. Kap. 6.2.
Dann wird die RS 232 Uber die beiden Modems durchgeschaltet.

. Steuern Sie |hr entferntes Gerét.

Alle Daten, die Sie vom PC an das lokale Modem senden, werden Uber die Telefonleitung an das Tixi
Message Modem AT und von diesem per RS 232 an das angeschlossene Gerat tibertragen.
Sie kdnnen es bedienen, als ob Sie direkt davor safien.

. Abbau der Verbindung durch

— Auflegen des anrufenden Modems
— optionale Zeitbeschrankung (Timeout) im Tixi-Modem
wenn keine Daten mehr kommen. (Default 75 Sekunden.)

Laufzeitverzégerungen bei Modemibertragungen
Durch eine Fernverbindung und die Datenumwandlung in den beiden Modems entstehen Verzdgerungen in der
Laufzeit der Daten vom PC zu der Steuerung im Vergleich zu einer direkten lokalen Verbindung tber ein RS 232
Kabel. Manche Konfigurations-Programme flir Steuerungen erwarten eine Antwort innerhalb von wenigen
Millisekunden. Bei diesen Programmen kdnnen Fehler auftreten. Fragen Sie den Hersteller dieser Programme
und Steuerungen, wie das Timeout fir die Kommunikation mit der Steuerung erhéht werden kann, z.B. auf 500

ms.

6.1 TransMode Befehl

AT+T SEND="TransMode; ..."

AT+T SEND="TransMode;Enabled:enabled;Password:password;Format:format;

Handshake:handshake ;Keep: timeout ;Baudrate :RS232Speed;Com:Port"

Schaltet bei Einwahl von au3en die RS 232 zu einem angeschlossenen Gerat durch,
so dass das Gerat ferngesteuert werden kann.

Enabled Schaltet den TransMode aktiv (On) oder inaktiv (OFF).
Password Zugangspasswort

Es schitzt Ihr Tixi Message Modem AT vor unbefugter Einwahl

und damit die angeschlossene Steuerung vor Benutzung durch Unbefugte.
Wenn kein Passwort angegeben ist (Default: leer) und AT+T Answer=“0n‘‘,
kann sich jeder einwéhlen.

format Datenformat der RS232-Schnittstelle.

Notation: DatabitsParityStopbits. Default: 8N1.

handshake Handshake-Protokoll der RS 232.

Werte: None, RTSCTS, XONXOFF, SUCOM
SUCOM gilt fur die Moeller EASY 400, 600 und 800 Klein-SPS.
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timeout Idle-Timeout
Legt fest, wie lange die Verbindung bestehen bleibt,
nachdem keine Daten mehr Gbertragen werden.
Der Defaultwert ist 75 Sekunden.
Ein Wert von 0 schaltet diese Funktion ab, d.h. das Tixi-Modem wird die Verbindung nicht
beenden, auch wenn keine Daten mehr kommen

RS232Speed Datengeschwindigkeit auf der RS 232
zwischen dem Tixi Message Modem AT und dem daran angeschlossenen Gerat.
Default-Wert: 115.200 Baud.

Port Remote-Schnittstelle, auf die durchgeschaltet werden soll.

Beispiel: Das Tixi AT Modem wird fuir den TransMode konfiguriert:

AT+T SEND=""TransMode;Password:sesam;Format:8N1;Handshake:None;Keep:20;
Baudrate:9600;Enabled:0On;Com:MB"

Bei Eingang eines Anrufes schaltet das Tixi-Modem die RS 232 zum angeschlossenen Geréat durch.
Alle Daten werden nun in beide Richtungen so Ubertragen, als ob die Gerate direkt verbunden waren.

6.2 Login-Kommando fir den TransMode
Um den TransMode des Tixi Message Modem AT zu nutzen, missen diese Voraussetzungen erfllt sein:

1. Das Tixi Message Modem AT muss mit einem durchwahlfdhigen Telefonanschluss verbunden sein,
das heisst, Sie missen es anrufen kénnen. (Probieren Sie das zuerst mit einem Telefon aus.)

2. Die Anrufannahme des Tixi-Modems muss aktiviert sein (AT+T Answer=""0n"").
3. Das Tixi Message Modem AT muss zuvor mittels des TransMode-Befehls konfiguriert worden sein.

Um sich tber eine Modem-Wahlverbindung und das Tixi Message Modem AT mit der an diesem
angeschlossenen Peripherie zu verbinden, miissen Sie sich zunéchst in das Tixi Message Modem AT
einwahlen.

Benutzen Sie dafir ein Tixi-Modem oder jedes andere Modem.

Senden Sie
spatestens fiinf Sekunden nach dem CONNECT

das Login-Kommando fiir den Transmode-Befehl.

Fur das Login-Kommando gibt es zwei Méglichkeiten:

a) Login ohne Parameter

[password] Login mit Passwort

1 Login ohne Passwort

b) Login mit Passwort und mit Parametern
[password;Format: format;Handshake :handshake ;Keep:timeout;Baudrate:RS232Speed]

(Parameterbeschreibung siehe Abschnitt 6.1)

Die Konfiguration des Message Modems sollte i.A. lokal erfolgen, getestet werden und erst dann fir die
Ferneinwahl freigegeben werden.

Das Fernandern der Parameter Giberschreibt die zuvor konfigurierten — und getesteten - Parameter.
Das Fernandern der Parameter sollte nur genutzt werden, wenn es unbedingt nétig ist.

Es kann auch immer verwendet werden, um eventuelle lokale Anderungen auszuschlieRen.
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7 TACO - Die Tixi AT-Console

7.1 Schnellstart

Die Tixi AT-Console ermdglicht Ihnen einen schnellen Einstieg in Konfiguration und Testbetrieb des Tixi
Message Modems und des Tixi Super Modems. Sie kdnnen hier alle notwendigen Parameter schnell erlernen,
einfach einstellen, diese Einstellungen auf der Festplatte speichern und sie ins Tixi-Modem Ubertragen.

Dabei brauchen Sie sich um die Syntax der Befehle nicht zu kiimmern, da die Konsole diese automatisch
generiert. Sie missen lediglich die Rufnummern, Nachrichtentexte u.a. Daten eingeben.

Um einen Eindruck von der Tixi AT-Console zu gewinnen, folgen Sie dieser Anleitung, um ein Testfax aus dem
Tixi AT Modem zu versenden.

1. Schliessen Sie das Tixi AT Modem an.
2. Installieren Sie die Tixi AT-Console TACO.

3. Starten Sie TACO.
Falls eine Fehlermeldung No response from modem erscheint, ist das Tixi AT Modem nicht an COM2
angeschlossen. Wahlen Sie im Meni [Options] > [RS232 Setup] aus, an welchen COM-Port Ihres PCs das
Tixi AT Modem angeschlossen ist.

4. Wechseln Sie auf die Registerkarte [ALL]. Tragen Sie dort unter [DialPrefix] eine ggf. benétigte
Amtsvorwahl ein; sonst lassen Sie das Feld leer. Geben Sie unter [ModemName] lhre Station-ID an und
unter [ModemNumber] die Rufnummer des verwendeten Anschlusses.

Klicken Sie auf den [Send] Button der Registerkarte [ALL], um diese Angaben im Tixi-Modem zu speichern.

5. Wechseln Sie auf die Registerkarte [Fax].
Tragen Sie unter [Dial] die Rufnummer des Empfangers ein (ggf. mit Ortskennzahl).

6. Geben Sie in der rechten Hélfte des Fensters in den Feldern [Subject] und [Message] einen Betreff und die
Nachricht ein. Klicken Sie auf den [Send] Button der [Fax] Registerkarte.

7. Der Befehl wird in das Tixi-Modem Ubertragen und sofort ausgefihrt.

7.2 Benutzeroberflache

Die Oberflache der Tixi AT-Console gliedert sich in zwei Teile: Links finden Sie Registerkarten fur jeden
Nachrichtentyp, auf denen die jeweils notwendigen Sendeparameter angegeben werden kdnnen. Rechts
kénnen Sie den Betreff und Text Ihrer Nachricht eingeben. Auch das Log-Fenster mit den Antworten und Status-
Informationen des Tixi AT Modem finden Sie hier.

7.2.1 Log-Fenster

Hier werden alle Riickmeldungen des Tixi AT Modem angezeigt. Benutzen Sie den Schalter [verbose reports]
auf der Registerkarte Misc, um ausfuihrliche Meldungen zu erhalten. Mit dem Button [Clear] kbnnen Sie den
Inhalt des Fensters jederzeit I6schen.

7.2.2 Menlleiste

Hier finden Sie einige weitere Optionen:

File > Save As - speichert die aktuelle Konfiguration auf der Festplatte

File > Load From - ladt eine zuvor gespeicherte Konfiguration von der Festplatte
File > Exit beendet das Programm

Options > RS232 Setup - konfiguriert die serielle Schnittstelle

Options > Load Parameters from Modem liest alle Parameter aus dem Tixi AT Modem aus
Options > Store Parameters to Modem  ({bertragt alle Parameter ins Tixi AT Modem
Command - Eingabefeld fiir beliebige Kommandos an das Tixi-Modem

Help - Fenster mit Angaben zur Versionsnummer u.a.
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7.2.3 Registerkarten mit den Sendeparametern

In den Eingabefeldern auf den Registerkarten finden Sie die Parameter wieder, die fiir das Kommando Send im
Kapitel 5.2 dieses Handbuches beschrieben werden. Der Button [Send] rechts unten Ubertragt die angegebenen
Parameter der aktuellen Registerkarte ins Tixi AT Modem.

Wenn auf der rechten Seite weder ein Betreff noch ein Text fiir die Nachricht angegeben ist, werden nur die
Parameter gesetzt; andernfalls wird mit den jeweiligen Parametern eine Nachricht generiert und versandt. Auf
der Registerkarte Get finden sich alle Funktionen zur Verarbeitung empfangener Nachrichten.

Hier ist ein kurzer Uberblick liber die Registerkarten und die darauf anzugebenden Parameter:

ALL - allgemeine Parameter fir alle oder mehrere Nachrichtentypen

DialPrefix - Amtsvorwahl

ModemName - Modemname fiir Express E-Mail und fur
Kopfzeilen ausgehender Faxnachrichten

ModemNumber - Rufnummer des verwendeten Anschlusses

SMS - Parameter fiir den Versand von SMS
ServiceCentreNumber - Rufnummer des SMS-Servicecenters

To - Rufnummer des Empféngers
Express - Parameter fiir den Versand von Express-E-Malil
Dial - Rufnummer der Gegenstelle — ggf. mit Ortsvorwahl mit fuhrender Null.
To - Express-E-Mail Adresse des Empfangers
From - Express-E-Mail Adresse des Absenders
Fax - Parameter fiir den Versand von Faxnachrichten
Dial - Rufnummer der Gegenstelle — ggf. mit Ortsvorwahl mit fuhrender Null.
EMail - Parameter fir den Versand von Internet-E-Mail
Dial - Rufnummer des ISP-Einwahlknotens
To - E-Mail Adresse des Empfangers
From - E-Mail Adresse des Absenders
PPPUser - Benutzername zum PPP-Login beim Provider
PPPPassword - Kennwort zum PPP-Login beim Provider
SMTPMailserver - Mailserver fiur ausgehende Nachrichten
PbS aktiviert POP-before-SMTP zum Nachrichtenversand
Get - empfangene Nachrichten im Log-Fenster anzeigen
Get Message List - Listet empfangene Nachrichten mit ihren ID-Nummern auf
Message ... - ID-Nummer der Nachricht, auf die sich eine der folgenden Aktionen bezieht:
Read Message - liest die unter [Message] angegebene Nachricht aus und zeigt sie an
Delete Message - I6scht die unter [Message] angegebene Nachricht
Misc - sonstige Parameter
verbose reports - aktiviert die Ausgabe ausfuhrlicher Riickmeldungen
Get Time - liest die Systemzeit des Gerates aus und zeigt sie im Log-Fenster an
Set Time - Dialog zum Setzen der Systemzeit im Tixi-Modem

TransMode - Parameter fiir den TransMode

Com Gibt den COM-Port an, auf den die Verbindung durchgeschaltet wird. Beim Tixi
Message Modem ist dies immer MB (Mainboard).
Baudrate Legt die zwischen Tixi Message Modem und angeschlossener Steuerung

verwendete Baudrate fest.
DataBitsParityStopBits Das verwendete Datenformat. Default ist 8N1.

Handshake Das verwendete Handshake-Protokoll zwischen Tixi und SPS.

Keep Leerlaufzeit, nach der die Verbindung getrennt wird. Geben Sie "0" ein, damit
nicht automatisch getrennt wird.

Password Geben Sie hier das Passwort ein, dass bei der Einwahl angegeben werden
muss, um unautorisierten Zugriff zu verhindern.

Enabled Aktivieren Sie dies, um den TransMode einzuschalten. Andernfalls werden nur

die Parameter gesetzt.
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Anhang A:

LEDs

Die LEDs am Tixi Message Modem AT und Tixi Super Modem AT sind gleich, nur am Tixi Super Modem AT
SMO03-CTS (gelbes Plastik-Wellgehause) gibt es andere LEDs.

SMO03-CTS

‘Alle anderen

Bedeutung

Power

Leuchtet , wenn das Tixi-Modem betriebsbereit ist und
blinkt im Falle eines schweren Fehlers.

RD

Leuchtet, wenn Daten per RS 232 empfangen werden.

TD

Leuchtet, wenn Daten per RS 232 gesendet werden.

V.90

Leuchtet, wenn eine 56k/V.90-Verbindung besteht.

Mail in

Process

Leuchtet, wenn das Tixi-Modem Signale verarbeitet oder wenn
Nachrichten eingegangen und noch gespeichert sind.

Line

Blinkt, wenn eine Verbindung hergestellt wird und
leuchtet, sobald die Verbindung steht.

Mail out

Data out

Leuchtet, solange sich zu versendende Nachrichten im Speicher befinden
und blinkt wahrend des Bootvorgangs.

Modem Mode

Leuchtet, sobald sich das Tixi Message Modem im

Modem Mode befindet.

Anhang B: Lieferumfang

Alle Tixi AT Modems werden mit Handbuch, CD-ROM mit Software und Anschlu3kabeln geliefert.

Geratetyp

Kabel

Office Line Tixi Modems

Mit 230 V Netzteil (EU)

SMO03-CTS
Tixi Super Modem AT V.90

1 Steckernetzteil EU (230V ~ auf 9V ~)
1 Telefonkabel (TAE auf RJ12)

1 RS232- Kabel (9/25-polig/B auf 25-polig/St)

SM03-BB _
Tixi Super Modem AT V.90 1 Steckernetzteil EU (230V ~ auf 12V ~)
EM20-BB 1 Telefonkabel (TAE auf RJ12)

Tixi Message Modem AT V.90 1 RS232- Kabel (9-polig/B auf 9-polig/St)
SD03-BB

Tixi Super Modem AT ISDN
ED20-BB

Tixi Message Modem AT ISDN
EF20-BB

Tixi Message Modem AT ISDN&Fax

1 Steckernetzteil EU (230V ~ auf 12V ~)
1 ISDN-Kabel (RJ45 auf RJ45)
1 RS232 Kabel (9-polig/B auf 9-polig/St)

Industry Line Tixi Modems

Mit 12 — 24 V DC Schraubklemme

SMO03-KA5

Tixi Super Modem AT V.90 1 Telefonkabel (TAE auf RJ12)
EM20-KA5 1 RS232- Kabel (9-polig/B auf 9-polig/St)
Tixi Message Modem AT V.90

SD03-KA5

Tixi Super Modem AT ISDN
ED20-KA5

Tixi Message Modem AT ISDN
EF20-KA5

Tixi Message Modem AT ISDN&Fax

1 ISDN-Kabel (RJ45 auf RJ45)
1 RS232 Kabel (9-polig/B auf 9-polig/St)

Blue Adapter

Bei Bedarf kann dieser Adapter bei lhrem Handler nachbestellt werden.
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Anhang C: Typ-Bezeichnungen der Tixi-Modems

Geréatetyp Modemtyp
S | Super Modem AT M | Analog Modem (56k / V.90
Message Modem AT D | Digital Modem (ISDN TA)
J | Alarm Modem F | ISDN-TA mit Faxmodem
G |GSM-Modem (GPRS optional)
Stromversorgung Gehause
B |[Buchse 12V AC, B | TMB-Gehause
230 V Steckernetzteil Alu-Well-Gehause
C |Buchse 9V AC, TS |+ .
230V Steckernetzteil Tixi Super Modem Gehéause
K | Schraubklemme, A5 | Alu-Kastengehause A50, H = 50mm
12-24V DC
A8 | Alu-Kastengehause A80, H = 80mm

Landerkennungen
fur Netzteile, Modems, TK-Kabel
D |Deutschland US |U.S.A.
UK | United Kingdom CH | Schweiz
EU | Europa F | Frankreich

Anhang D: Garantie und technische Unterstiitzung

Garantieleistungen

Dieses Gerat wurde nach den modernsten Methoden hergestellt und geprift. Der Hersteller tbernimmt fir zwei
Jahre, gerechnet vom Tage des Verkaufs, Garantie zu den nachfolgenden Bedingungen:

Innerhalb der Garantiezeit werden alle Mangel kostenlos beseitigt. Reklamationen sind unmittelbar nach
Feststellung zu melden. Fir Vollkaufleute besteht die Rugepflicht innerhalb von sieben Tagen.

Der Hersteller behélt sich vor, bei Reklamationen die defekten Teile auszubessern oder zu ersetzen oder das
Gerat auszutauschen. Ausgetauschte Teile gehen in sein Eigentum tber. Die Garantiezeit fir ausgetauschte
Teile endet mit der Garantiezeit fir das gesamte Gerat.

Der Hersteller ist berechtigt, im Rahmen der Garantieleistungen technische Anderungen (z.B. Firmware-
Updates) vorzunehmen, um das Gerat dem aktuellen technischen Stand anzupassen. Dem Erwerber entstehen
hierdurch keine zuséatzlichen Kosten. Ein Rechtsanspruch hierauf besteht nicht.

Der Garantieanspruch erlischt bei Eingriffen durch den Kaufer oder durch Dritte. Schaden, die durch
unsachgemalle Behandlung oder Bedienung, durch falsches Aufstellen oder Aufbewahren, durch
unsachgemallen Anschluss oder Installation sowie durch héhere Gewalt oder sonstige aulRere Einflisse
entstehen, fallen nicht unter die Garantieleistungen. Weist das Gerat mechanische Beschadigungen
irgendwelcher Art auf, sind Garantieanspriiche ausgeschlossen.

Das Recht der Bundesrepublik Deutschland findet Anwendung.

Technische Unterstiitzung

Falls es im Betrieb des Tixi AT Modem einmal zu Problemen kommen sollte, setzen Sie sich bitte mit der
technischen Hotline Ihres Fachhandlers in Verbindung. Ubermitteln Sie dazu bitte diese Angaben:

» Fehlerbeschreibung. Der Fehler sollte reproduzierbar sein, damit er behoben werden kann.

Die Versionsnummer der Tixi AT Modem Firmware - diese erfahren Sie, wenn Sie im Modem Mode
Uber ein Terminalprogramm den Befehl AT11 an das Gerét senden.

. Die Art Ihres Telefonanschlusses (Anbieter, freigeschaltete Dienstmerkmale, Telefonanlage)

*  Angaben Uber die Gegenstelle — (Typ: Faxgerat, Modem, Telefonanlage, Software etc.).
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Anhang E: Express E-Mail Graphik
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